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This user guide provides an overview of Wolfspeed’s CRD-25BDA6512N-K 25kW Bi-Directional T-Type Inverter
reference design including key system specifications, system design, hardware setup and test procedure, and
test results. CRD-25BDA6512N-K is designed with 25mQ 650V and 32mQ 1200V SiC MOSFETSs. Utilizing SiC
MOSFETs in this topology for solar PV inverters, uninterruptible power supplies (UPS), and other similar
applications may boost system efficiency and power density compared to Si-based solutions.
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This document is prepared as a user guide to install and operate Wolfspeed evaluation hardware.

All parts of this user guide are provided in English, and the Cautions are provided in English, Mandarin, and
Japanese. If the end user of this board is not fluent in any of these languages, it is your responsibility to ensure
that they understand the terms and conditions described in this document, including without limitation the
hazards of and safe operating conditions for this board.
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Note: This Wolfspeed-designed evaluation hardware for Wolfspeed components is a fragile, high voltage, high
temperature power electronics system that is meant to be used as an evaluation tool in a lab setting and to be
handled and operated by highly qualified technicians or engineers. When this hardware is not in use, it should be
stored in an area that has a storage temperature ranging from -40° Celsius to 105° Celsius. If this hardware is
transported, special care should be taken during transportation to avoid damaging the board or its fragile
components and the board should be transported carefully in an electrostatic discharge (ESD) bag, or with ESD
or shorting protection that is the same as or similar to the protection that is or would be used by Wolfspeed when
shipping this hardware, to avoid any damage to electronic components. Please contact Wolfspeed at
forum.wolfspeed.com if you have any questions about the protection of this hardware during transportation.
The hardware does not contain any hazardous substances, is not designed to meet any industrial, technical, or
safety standards or classifications, and is not a production qualified assembly.
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CAUTION
PLEASE CAREFULLY REVIEW THE FOLLOWING PAGES, AS THEY CONTAIN IMPORTANT INFORMATION
REGARDING THE HAZARDS AND SAFE OPERATING REQUIREMENTS RELATED TO THE HANDLING AND USE
OF THIS BOARD
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CAUTION

DO NOT TOUCH THE BOARD WHEN IT IS ENERGIZED AND ALLOW THE BULK CAPACITORS TO
COMPLETELY DISCHARGE PRIOR TO HANDLING THE BOARD. THERE CAN BE VERY HIGH VOLTAGES
PRESENT ON THIS EVALUATION BOARD WHEN CONNECTED TO AN ELECTRICAL SOURCE, AND SOME
COMPONENTS ON THIS BOARD CAN REACH TEMPERATURES ABOVE 50° CELSIUS. FURTHER, THESE
CONDITIONS WILL CONTINUE FOR A SHORT TIME AFTER THE ELECTRICAL SOURCE IS DISCONNECTED
UNTIL THE BULK CAPACITORS ARE FULLY DISCHARGED.

Please ensure that appropriate safety procedures are followed when operating this board, as any of the
following can occur if you handle or use this board without following proper safety precautions:

e Death

e Serious injury

e Electrocution

e Electrical shock

e Electrical burns

e Severe heat burns

You must read this document in its entirety before operating this board. It is not necessary for you to touch
the board while it is energized. All test and measurement probes or attachments must be attached before the
board is energized. You must never leave this board unattended or handle it when energized, and you must
always ensure that all bulk capacitors have completely discharged prior to handling the board. Do not
change the devices to be tested until the board is disconnected from the electrical source and the bulk
capacitors have fully discharged.
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1. Introduction

This user guide overviews the design theory, schematic, artwork and test setup necessary to evaluate
Wolfspeed’s CRD25BDA6512N-K, 25KW Bi-Directional T-Type Inverter for solar inverters, uninterruptible power
supplies (UPS), and similar applications. In conjunction with this user guide, the complete suite of reference
design files including schematics, PCB layout, Gerber files, BOM, and firmware are available for download from
the CRD-25BDA6512N-K product page on Wolfspeed’s website.

The CRD-25BDA6512N-K is the inverter stage of the solar PV architecture connected to the AC grid based upon
Wolfspeed’s 3™ generation SiC MOSFETs - C3M0032120K (1200V, 32mQ, TO-247-4) and C3M0025065K (650V,
25mQ, TO-247-4). Included on this single PCB solution is a DC-link bus capacitance with low-inductance power
planes, gate drivers, current and voltage sensing, thermal management, various control peripherals and output
LC filter. The converter is a bi-directional design, and therefore can operate in inverter mode providing a 3-
phase balanced AC voltage on the output when a DC voltage is supplied as input and can operate in PFC mode
providing a DC voltage output when a 3-phase AC voltage is supplied at 3-phase input side.

Gl A 4 F ) C3M0032120K 4 F ) C3M0032120K L C3M0032120K
— G2 A = H G1 B H G1_C H Vinv
G3 A
q v £)
G2 B G3_B
2 x C3M0025065K linv_a
\V/ \ TF 1T ~ 6 Vac
BUS J7 G2_C G3.C j ouT
2 x C3M0025065K linv_B
2 X C3M0025065K e 11
= — %
— C3M0032120K C3M0032120K H'} C3M0032120K
G4_A G4_B G4_C H

Aphase Bphase Cphase

E] [] |GlGZG3G4: |GlGZG3G4: le1 GZG3G4:
Vaus Sense I i AL . i L . 5 15

¢ VmpSense ) P UCC5350MC Gate Drive IC
Texas Instruments
[] F28379D Controller linv_a +15V/-3V
Vinv linv_B
linv_c
+5V
Flyback Power Supply +— Vg

Figure 1: Block Diagram of Wolfspeed’s CRD25BDA6512N-K, 25KW Bi-Directional T-Type Inverter

The output power fluctuation of renewable energy sources and increasing power demand on the electric grid
bought by the EV transformation puts increased stress onto the existing grid. Abi-directional converter s crucial
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to help manage the grid since it is able transfer energy between the renewable energy source, the storage
battery (which caninclude an EV battery), and the electric grid depending on the demand.

For the inverter stage in a bi-directional system, the two-level three-phase inverter is very popular due to its
simplicity and ease of control. Since there are only two voltage levels, two-level inverters have relatively higher
output THD. The solar industry’s move towards higher bus voltages of 1000V or 1500V to reduce the current
flowingin the circuit poses a major challenge in the use of two-level inverters due to the inverter’s THD at higher
voltages. Multilevel converters help to solve this problem of high THD by employing multiple input voltage
levels and can operate at higher switching frequencies, higher voltages, and higher power without
compromising on efficiency [2]. This also helps to reduce the size of the system because a smaller EMI filter may
be utilized. A T-type converter has a simple structure and lower cost compared to other multi-level topologies
due to a lesser number of power devices than other multi-level topologies like the I-type and active-NPC.

Utilization of SiC MOSFETSs in T-type inverters can improve efficiency and power density [3]. This design shows
the SiC MOSFETSs switching at a 60kHz switching frequency to achieve a power density of > 6kW/L while still
maintaining a peak efficiency of >99%.

2. Description

The CRD-25BDA6512N-K reference design board uses Wolfspeed’s 3rd generation SiC MOSFETs - C3M0032120K
(1200V, 32mQ, TO-247-4) in the high-side and low-side switch positions of all three phases and two
C3M0025065K (650V, 25mQ, TO-247-4) in the T-side position of all three phases.

In inverter mode, this board can be tested by using DC source at the input and 3-phase resistive load at the
output. This design uses third harmonic injection pulse width modulation (THI PWM) technique for wide input
voltage range in inverter mode. This unit has not been tested with a grid —-connection, and a grid-connection
algorithm is not tested in the firmware currently. In PFC mode, this board can be tested using a 3-phase AC
source at the input and a DC resistive or E-load in constant R mode at the output.

The firmware is built and loaded into the control card using Texas Instrument’s Code Composer Studio
integrated development environment (IDE). There is no GUI for this design. The details of using the firmware in
CCS are shared in Hardware Testing Section 4.2.

2.1 Key Electrical Specifications
Table 1: Specifications of Wolfspeed’s CRD-25BDA6512N-K, 25kW Bi-Directional T-Type Inverter

Parameter Test Conditions Min. Nom.
Inverter DC Input Characteristics
Vinpo) Input voltage 670 800 900 Vims
fow Switching frequency 60 kHz
PFC DC Output Characteristics
Vout(dc) Input voltage 670 800 900* Vims
fow Switching frequency 60 kHz
AC Side Input/Output Characteristics
Vourag | Output L-L RMS voltage | | 380 | 400 | 480" | v
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|OUT(RMS) OUtpUt RMS current Vin= 800V, Pour = 25kW 36 A
Pout max Output Power 25000 W
fac Output Line Frequency 50/60 Hz
DC-AC System Characteristics
V|N = 800V,
Npeak Peak efficiency Vour = 400V rus, 99%
lout = 40% of louT(nom)
V|N = 800V,
Nfull load Full load efficiency Vour=400 VL_ rws, 98.5%

lout = 100% of lout(nom)

AC-DC System Characteristics

Vin=480 V.., RMS,
Npeak Peak efficiency Vour = 800V, 99.25%
|ou'|' =50% of |0UT(nom)
Vin =400 Vi rus,
Npeak Peak efficiency Vour =800V, 99%
lout = 50% of lout(nom)

Nfull load Full load efficiency 98.5%
Mechanical
Width 235
Dimensions Length 320 mm
Component height 50

*Output voltage is derated at low-line input voltage

2.2 Applications

The primary applications for Wolfspeed’s CRD-25BDA6512N-K reference design board are solar inverters,
uninterruptible power supplies (UPS), fast charging, industrial power supplies, and other energy storage
systems. Using a DC input from the solar panel array, this design provides a non-isolated AC output that can
supply power to various commercial/residential loads or to the AC grid.

2.3 Features
Some of the features of Wolfspeed’s CRD-25BDA6512N-K reference design board are listed below:

e Bi-directional operation with 25kW output in both power flow modes

o Peak efficiency > 99%

e Power density > 6kW/L

e Third Harmonic Injection Pulse Width Modulation (THI PWM) for inverter mode
e Protection functions listed in Table 3

e Programmable switching frequency from 47 to 60kHz
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e Electrical performance of the inverter can also be evaluated in open-loop

3. System Design

3.1 Topology Selection

A T-type NPC inverter is a multi-level inverter for 3-phase converters. For an 800V DC bus system, the main leg
devices must block the full DC link voltage and therefore must be 1200V rated devices as shown in figure 2. The
side bi-directional devices only need to block half the DC link voltage and are therefore 650V rated devices. The
bi-directional switch can be implemented in either a common-drain configuration or a common-source
configuration. A common-drain configuration is chosen for CRD-25BDA6512N-K due to being able to use two
fewer gate bias power supplies and saving cost and space on the board, more details of which are shared in

+o
e
—
Voc/2 650V

Devices

1200V
1200v Devices
Devices O p

Voc/2 Voc/2

Section 4.

Voc/2 650V
Devices

-0

(a) (b)
Figure 2: Single leg of the T-type Inverter topology (a) Bi-directional switch Common-Drain configuration (b) Bi-
directional switch Common-Source configuration

For a single phase of the T-type inverter topology, three voltage states are possible: DC+, DC- and 0V. As a three-
level topology, it exhibits good total harmonic distortion (THD) performance, allowing for smaller output
inductors. With fewer components and superior conduction losses compared to NPC topology, TNPC was
selected for the CRD-25BDA6512N-K reference design board.

3.2 MOSFET Selection

Traditional switching devices like Si IGBT technology have low “on-state” static losses but have slow switching
performance and therefore much higher dynamic or switching losses. This limits their application to low
switching frequencies which require bulky and large magnetics. SiC MOSFETs can switch much faster than Si
IGBTs and therefore have lower switching losses. Table 2 compares the power losses for SiC MOSFETs and Si
IGBTs in 25kW T-type inverter simulation.
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Table 2: Comparing power loss for SiC MOSFET and Si IGBT at 25kWW power

N
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Inverter Mode PFC Mode
p Devi DC-link MOSFET: 32mQ 1200V SiC | DC-link IGBT: 50A1200VSi | DC-link MOSFET: 32mQ 1200V SiC | DC-link IGBT: 50A 1200V Si
ower Device side MOSFET: 25mQ 650V SiC Side IGBT: 50A 650V i side MOSFET: 25mQ 650V SiC Side IGBT: 50A 650V Si
Switching Frequency 60kHz 24kHz 60kHz 24kHz
Heatsink Temperature 85°C 85°C 85°C 85°C
Rih,ch 0.5°C/W 0.5°C/W 0.5°C/W 0.5°C/W
Efficiency* 98.9% 98.85% 99.06% 98.65%
Switching 75.79 W 127.14W ow ow
osses
DC-Link -
MOSFET | CCpouction 129.17W 104.16 W 115.86 W 138.55 W
Total Losses 204.96 W 231.3W 115.86 W 138.55W
Switching
. Losses oW ow 50.16 W 97.44 W
ide -
moser | COrouction 70.1W 55.5W 67.34W 99.13 W
Total Losses 70.1W 55.5W 117.5W 196.6 W
Total Losses 275.06 W 286.8 233.36 W 335.12W
7j of DC-Link Device 134.9 °C 134.7°C 114.3°C 115.1°C
Tj of Side Device 97.7°C 91.8°C 109.1°C 125.4°C
* Efficiency is for power devices only. EM filter, PFC choke, Aux power and control circuit are not included

From Table 2, it is noted that even though the switching frequency for Si IGBTs is 24kHz, which is much lower
than that of SiC MOSFETSs, the power loss for both inverter and PFC modes are higher than that of SiC MOSFETSs.
This clearly shows that the inverter will have much higher efficiency with SiC MOSFETs even after including the
system magnetics, which will be smaller with SiC. Fig. 3 shows a weight and size comparison between the two
chokes that would be needed for switching frequency of 60kHz for SiC and 24kHz for IGBTs. A SiC solution
provides higher efficiency, lower magnetics cost, and reduced size and weight, and is therefore a higher-power-
density solution for bi-directional grid-tied inverters.

SiC Solution- 64kHz

(700g) x 3=2100g

IGBT solution-

Lighter Weight

(1600g) x 3=4800g

24kHz

—

Higher Inductance Cost

Figure 3: Weight of PFC choke comparison for SiC and IGBT switching frequency
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3.3 Gate DriverIC

For the gate driver IC, the design uses the Texas Instruments UCC5350MC isolated gate driver, which has a
sink/source drive strength of +5 A. The selected gate driver IC includes an active Miller clamp. The active Miller-
clamp function helps to prevent a false turn-on of the power switches caused by Miller current. The Miller-
clamping function is implemented by adding a low-impedance path between the gate of the power device and
the VEE2 supply. Miller current sinks through the clamp pin, which clamps the gate voltage to be lower than the
turn-on threshold value for the gate. The gate driver IC also includes other built-in functionalities such as
undervoltage lockout, low propagation delay, and high common-mode transient immunity. More details about
the built-in features of the gate driver IC can be found in the Texas Instruments UCC5350MC datasheet.

7 7
i |
i |
i | ,J]
o uvLg2 Veez
Vor | 1 L— Ve q
i |
e
P &
g !
i |
IN: x
i ! Shifing —{
i 1 and
H Control
i Logic Jout
|
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1z
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|
i |
I | 4{
GND1[ ) i 1
| Ve
i | E=
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Figure 4: UCC5350MC functional block diagram

3.4 LCFilter Design

The EMI filter is intended to remove any high-frequency noise propagating to the grid and address the issue of
common-mode noise. A standard procedure to eliminate differential noise in grid-connected systems is
incorporating an LC filter [4]-[6] topology shown in figure 5. Proper damping needs to be applied to ensure
resonant peak is kept under control. A review of various damping topologies for the LC filter has been evaluated
in [7]. Following the step-by-step methodology provided in [4], the LC filter component sizes have been
determined. The input parameters utilized for this calculation are:

o Pou=25kW
e F,=50Hz
o F,~=64kHz
e E,=230V

This yields the following parameters for the Liwv and Cou:
o Linv=102uH
o Com=24.9 uF

Even though using this calculation and methodology derives a higher Cou, only 10uF is used as the goal of this
filter is to provide only nominal noise suppression and not be in compliance with any EMI standards. A separate
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EMI filter board that is an add-on to the CRD-25BDA6512N-K board has been designed and optimized to IEC
61000-6-3, standard for emissions. The user can request more details about this on Wolfspeed Power
Applications Forum.

Linv, A
Vin, A m Verio, A
Linv, 8
Vin,s o m Verio, 8
Linv,
Vin, ¢ m Verio, ¢
Com, A Com,8]  Com,
R¢,a Rt,8 Rf,c

Figure 5: LC filter topology
The inductor design for the selected value is based on the following constraints:

e Height of the component needs to be <40 mm

e Volume of the inductor needs to be minimized

e Inductor power loss needs to be minimized

e Temperature of the PFC choke needs to be < 120°C
e No-load inductance is not too high

The area-product method has been utilized to find out if a core is compatible with the design. The eligible cores
from the previous step have been run through the design procedure provided by [8]-[9]. A user can request more
details about the magnetics design and request a datasheet on Wolfspeed Power Applications Forum.

3.5 Controller Selection

Texas Instruments TMS320F280039C is chosen as the controller IC for this design. It is a member of the C2000™
real-time microcontroller family by Texas Instruments. The user can read more about features of this controller
in TMS320F28003x’s datasheet.

For simplicity of design, the control card TMDSCNCD280039C is directly used in CRD-25BDA6512N-K. Although
the height of this control card is taller than the 40mm specification for this design, the control card can easily
be re-designed to lower the height by connecting only the necessary pins used for the design.

3.6 Thermal Design

Power switches of each phase are placed on a heatsink. Forced air cooling is used for this design. As seen from
Table 2, in the inverter mode the 1200V switches have more power losses than the 650V switches (and therefore
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higher temperature), and vice-versa in PFC mode. Placing these devices on the same heatsink next to each other
allows for thermal coupling, providing more area to cool the hotter switch. Figure 6 shows the placement of
devices on the heatsink, showing each 1200V and 650V switch placed alternatively for thermal coupling, to
minimize the switching node trace and to minimize the gate loop. This design also allows for the same air from
the heatsink to flow over to the PFC choke for cooling.

Cooling Fan

PFC choke Airflow

a1l Q3 Q2 Q4
(High-Side) (Side-switch) (Low-Side) (Side-switch)
C3M0032120K C3M0025065K C3M0032120K C3M0025065K

Figure 6: Position of devices on heatsink

AIN ceramics of 1mm width are chosen for the thermal interface material (TIM) for each switch as it provides
excellent thermal conductivity. Based on the power loss estimation for each device, the thermal impedance of
the MOSFET from junction to case and the thermal impedance of the TIM, analysis is carried out to select the
right heatsink offering the optimum thermalimpedance to keep the junction temperature of the MOSFET below
135°C. BOYD 780453B extrusion profile was selected with Max Clip MAXO3NG-ND mounting for each switch
based on this analysis. A user can refer to the section 3 in Thermal Management of Bottom-Side Cooled Surface
Mount Devices and Design Considerations application note to understand more about how these thermal

calculations are performed.

4. Schematics

The schematics for this design can be downloaded from CRD-25BDA6512N-K 25kW T-type Inverter Product Page
> Download Design files.

Figure 7 (a) shows the top-sheet labelled Power Stage 1.SchDoc. The schematic is set up using multi-sheet
feature on Altium where each “repeat” sub-sheet is for similar circuitry for each phase. PGND is the midpoint of
the DC-bus voltage. The control GND can be left floating or can be connected to the DC- or midpoint depending
on the control strategy employed by the user. For testing this board, the control GND is left floating as shown
in Figure 7 (b),i.e.,no jumperis placed across P13 or P14. PGND terminal shownin figure 7 (c) is used to interface
with an external EMI filter.
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Remove pin 2 from P13 and P14 e 2 =
2
1
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(b) (c)
Figure 7: Power Stage 1.SchDoc (a) Repeat Sub-sheets (b) Control Power GND connection (c) Terminal for PGND
Mid-point DC

Subsheet PowerStage.SchDoc is the schematic for the MOSFETs, some of their gate drive components, and the
LC filter for each phase as shown in figure 8. Each sheet in the .pdf version is sheet numbered x.1, x.2 and x.3 for
phase A, B and C respectively where x is the main sheet number for the repeat sheets. The heatsink shown on
thissheetis also per-phase. The board comes populated with the jumper to tie to heatsink PGND (DC Mid-point).
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Figure 8: PowerStage.SchDoc

Figure 9 shows subsheet PWM Buffer.SchDoc which is the PWM buffer for all the 4 gate signals per phase.

I

Figure 9: PWM Buffer.SchDoc

The Gate Drive_High-Side_Switching Node.SchDoc shown in figure 10 is also a repeat sheet which shows that
gate drive bias supply of +15/-3V for the gate source voltage of the MOSFET is generated using a push-pull circuit
with TI’s SN6507 push-pull transformer driver IC and 750320528 transformer from Wirth Elektronik that offers
alow profile. Thisis a low-cost discrete implementation for generating the gate drive voltage. Using a common-
drain design for the 650V side MOSFETSs allows the design to use the same supply for the high-side switch (Q1)
and one of the side MOSFETSs (Q3) that are referenced to the same switching node for each phase.
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Figure 10: Gate Drive_High-Side_Switching Node.SchDoc

The interwinding capacitance of this transformer for push-pullis ~9pF, which is high and can result in more EMI.
For new designs, customers can also consider using LLC topology for bias power supply generation instead of
push-pull for a low-cost discrete supply.

Figure 11 and figure 12 show the implementation of gate drive bias power supply and gate driver for all low-
side switches (Q2). Gate Drive_Low-Side_Power supply.SchDoc is not a repeat sheet, as the low-side switches
of all the phases A, B and C share the same power supply and are referenced to the same DC- node. Gate
Drive_Low-Side.SchDoc is a repeat sheet as each low-side switch has its own gate driver IC.

[ 0 I : I

— :
I
| l ‘ | i - P v
L 1 |
< |
Wolfspeed.
T 0 T
Figure 11: Gate Drive_Low-Side_Power supply.SchDoc
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Figure 12: Gate Drive_Low-Side.SchDoc

Figure 13 and figure 14 show the implementation of gate drive bias power supply and gate driver for all the 650V
side switches at are referenced to the mid-point (Q4). Gate Drive_Mid-point_Power supply.SchDoc is not a
repeat sheet as the 650V side switches of all the phases share the same power supply and are referenced to the
same PGND node. Gate Drive_Low-Side.SchDoc is a repeat sheet as each middle-side switch has its own gate

driver IC.
23
[ ==
I 0 I I C I
Figure 13: Gate Drive_Mid-point_Power supply.SchDoc
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Figure 14: Gate Drive_Mid-point.SchDoc

This approach of common-drain topology for 650V side switches allows the design to use five discrete gate
voltage bias power supplies instead of seven, which would be required for a common-source 650V side-switch
topology, saving cost and space on the board.

Power Supplies.SchDoc is shown in figure 15. The user has an option to use an external 15V supply to power the
control/auxiliary components on the board or use a Wolfspeed auxiliary flyback board that can be provided
with the main board on request to generate the isolated 15V.

I

. ‘
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Figure 15: Power Supplies.SchDoc
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Voltage Sensing.SchDoc in figure 16 shows the DC input voltage sensing, U5 IC, which is a 4-channel op-amp IC
OPA4340UA used for feedback of the output inverter phase voltage sensing, and connector J6, which is used to

interface with an external EMI filter in case external VGrid needs to be sensed.

Figure 16: Voltage Sensing.SchDoc

Figure 17 shows Phase Protection.SchDoc is a repeat sheet with the AC line facing relay circuitry and inrus

current limiters for each phase.

—
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Figure 17: Phase Protection.SchDoc
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The Phase Sensing.SchDoc in figure 18 contains the current, phase voltage and temperature sensing for each
phase. The current is sensed using a Hall-effect-current-sensing IC ACS733KLATR-65AB-T by Allegro. This IC is
capable of sensing AC current where 0A corresponds to 1.65V. Since the current in the Hall IC flows from IP- to
IP+in inverter mode and IP+ to IP- in PFC mode, the current direction is calibrated accordingly in the firmware.

Voltage Sensing Temperature Sensing

Current Sensing

g

—
Wolfspeed.

™ CRD2SBDABS12N-K 25KV

[Fenate cRD2EBDARS 12+

vy [~

Figure 18: Phase Sensing.SchDoc

The Resistor String.SchDoc and Voltage Feedback.SchDoc make up the circuit that sense AC phase voltage
shown in figure 19. They feed into U5 op-amps that are part of the Voltage sensing.SchDoc. Since the op-amp
IC has four channels that are used individually for each phase, that IC couldn’t be part of the “repeat” sheets as
itis the same IC for all phases.
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Figure 19: (a) Resistor String.SchDoc (b) Voltage Feedback.SchDoc
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Similarly, Current Sense.SchDoc in figure 20 has U13 which is a 4-channel op-amp IC OPA4340UA and is not a
“repeat” sheet asit’s the same IC for all the phases and the output from U11 (Phase Sensing.SchDoc) feeds into

these op-amp channels.

1 I

Figure 20: Current Sense.SchDoc

Figure 21 shows the Control Card Connector Up.SchDoc with the connections to control card TMDSCND28039C,
the 1.65V generation circuit and CAN communication pins. The CAN communication pins have not been tested
but are still placed on the schematic for future improvements to the design.

FAN CONTROL

—
Wolfspeed.
™ CRD2SBDAES12NK
[T CRD25BDABS12N-+
T e

Figure 21: Control Card Connector Up.SchDoc
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5. Hardware Set-up & Testing

CAUTION

IT IS NOT NECESSARY FOR YOU TO TOUCH THE BOARD WHILE IT IS ENERGIZED. WHEN DEVICES ARE
BEING ATTACHED FOR TESTING, THE BOARD MUST BE DISCONNECTED FROM THE ELECTRICAL SOURCE
AND ALL BULK CAPACITORS MUCH BE FULLY DISCHARGED.

SOME COMPONENTS ON THE BOARD REACH TEMPERATURES ABOVE 50° CELSIUS. THESE
CONDITIONS WILL CONTINUE AFTER THE ELECTRICAL SOURCE IS DISCONNECTED UNTIL THE BULK
CAPACITORS ARE FULLY DISCHARGED. DO NOT TOUCH THE BOARD WHEN IT IS ENERGIZED AND
ALLOW THE BULK CAPACITORS TO COMPLETELY DISCHARGE PRIOR TO HANDLING THE BOARD.

PLEASE ENSURE THAT APPROPRIATE SAFETY PROCEDURES ARE FOLLOWED WHEN OPERATING THIS
BOARD AS SERIOUS INJURY, INCLUDING DEATH BY ELECTROCUTION OR SERIOUS INJURY BY
ELECTRICAL SHOCK OR ELECTRICAL BURNS, CAN OCCUR IF YOU DO NOT FOLLOW PROPER SAFETY
PRECAUTIONS.
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Figure 22 shows the CRD-25BDA6512N-K power board. The input DC power supply is connected to terminals
“DC+” and “DC-". The DC-Bus E-caps between DC+ to mid-point (PGND) and DC- to mid-point (PGND) are equally
divided across the 2 edges of the board to minimize the commutation loop for all switches. These, along with
the high-frequency film capacitors, form the DC Bulk Capacitors.

Each phase is placed linearly in front of the fan. Closest to the airflow is the heatsink and the MOSFET, then the
LC filter, then inrush current limiters and relays finally connected to the output terminal for that phase. The four
MOSFETSs for each phase are positioned in a way that minimizes the switching node trace on the PCB.
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Figure 22: CRD-25BDA6512N-K reference design hardware

5.1 Importing Firmware

To start testing this design, please request the firmware of this design from the CRD-25BDA6512N-K 25kW T-
type Inverter Product Page > Request separately > Request Firmware. Save the file to a local directory. To open
the project:

1. Install Code Composer Studio (CCS version 10.1 or above)

2. Install C2000Ware DigitalPower SDK package Version 4.04 from Texas Instruments tool page.
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3. Open CCS, and create a new workspace

4. Inside CCS, go to File > Open Projects from File System > Import source > Directory and navigate to the
firmware folder that you received and saved on your PC > finish. Your CCS window should now look like

figure 23.
&3 25KWType - Wolfspeed_25kW_T-typelnv_Firmware/tiny_user_settings.h - Code Composer Studio - o X
File Edit View Navigate Project Run Scripts Window Help
(=57 Bis-i@g-R-iRiy-BE LCR R Q ®|B%
& [ Project Explorer X = O [ Getting Started [g) tinv_main.c [) tinv_settings.h [R) tinv_user settingsh X | [g) tinv_03x.h [9) tinv_03x.c =0 s
B B®Y § 17 s |2
VS Wolfspeed 25kW_T-typelnv_Firmware B
@
e opyright (€) 2023 Texas I I p d - http
¥

LL RIGHTS RESERVED

ine TINV_PROTECTION_ENABLED 1
define TINV_PROTECTION_DISABLED @

d and v

30 #define TINV_TEST SETUP_RES_LOAD @
31 #define TINV_TEST_SETUP_GRID_CONNECTED 1
32 #define TINV_TEST_SETUP_PFC_RES_LOAD 2

6js
setupdebugeny_lab7.js

ine TINV_INVERTER MODE @
ine TINV_RECTIFIER_MODE 1

def C28x_CORE
ine C28x CORE 1

Writable Smart Insert 9:49:320 =

Figure 23: CCS window after importing firmware

5.2 Building, Loading and Debugging the Firmware

To build the project, right-click on the project name and click ‘Build Project’. To load the project, first make
sureinthe Project Explorer the correct target configuration file is set as Active under targetConfigs (*.ccxml file).
Then, click Run > Debug to launch a debugging session.

To debug the system one would monitor the variables in the watch/expressions window. To populate this
window with the correct variables, click View > Scripting Console to open the scripting console dialog box. On
the upper right corner of this console, click on Open and then browse to the “setupdebugenv_lab#X.js” script
file located inside the project folder. This will populate the watch window with the appropriate variables
needed to debug the system. Enable Continuous Refresh button on the watch window to enable continuous

update of values from the controller.

Real-time emulation is a special emulation feature that allows windows within Code Composer Studio to be
updated while the MCU is running. This allows graphs and watch views to updated, but also allows the user to
change values in watch or memory windows and see the effect of these changes in the system without halting

the processor. To enable real-time mode, click * on the top bar of CCS. A message box may appear. If so,
select YES to enable debug events.
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In different labs, sometimes the measured currents and voltages or control variables need to be verified by
viewing the data in the graph window. For this Graph window can be used which in conjunction with a piece of
code that runs on the controller can show a snapshot of how the values are being sensed by the controller. The
values are logged by the datalogger typically in the slower ISRs. To import the graph into the CCS view, select
Tools > Graph > DualTime, and click Import and point to the graphl.GraphProp file inside the project folder.
Two graphs will appear in CCS. Click Continuous Refresh on these graphs. A second set of graphs can also be
added by importing the graph2.GraphProp file.

You can also refer to TIDA-01606 10-kW, bidirectional three-phase three-level (T-type) inverter and PFC
reference design’s user guide for more details on each file, ISRs, ADC loading, CPU loading and information on
control variables.

5.3 Protections

Table 3 describes over/under voltage protection (OVP/UVP) and over current protection (OCP) functions in the
reference design. OCP protection is a one-shot protection that requires a system reset to clear the fault and
restart.

A user should not overload the converter out of the SOA (Safe Operation Area). This may damage the

unit.
Table 3: Protection Details
Power Signal Protection Trip Point Control Variable
Input/Output DC Voltage OVP >900V TINV_VBUS_OVERVOLT_LIMIT
DC mid-point Voltage OvP >450V TINV_VMID_OVERVOLT_LIMIT
AC Voltage UVP <50VAC TINV_UNIVERSAL_GRID_MIN_VRMS
Phase Current ocCP 40A (rms) TINV_IINV_TRIP_LIMIT_AMPS

The user is required to set appropriate limits on the supply and load equipment that is used for testing in order
to remain within the SOA of the board.

5.4 Hardware Equipment

DC Input Source: The input source must be an adjustable DC source whose output can be adjusted up to the
maximum bus voltage desired for testing up to 900V. It must be capable of supplying at least the rated power
of the intended load with 10-20% margin.

AC Input Source: The input source must be an adjustable AC source whose output can be adjusted between
220VAC to 277VAC. It must be capable of supplying at least the rated power of the intended load with 10-20%
margin.

Output AC Load: A high-voltage 3-phase resistor load bank can be used for PFC mode testing. Each phase must
be capable of sinking 38A of load current supplied from the evaluation board whose output can be 220VAC-
277VAC at 25kW.
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Output DC Load: A programmable high-voltage electronic load or a high-voltage resistor bank may be used.
Each must be capable of sinking 39A of load current supplied from the evaluation board whose output can be
650-900VDC/25kW.

Power Meter: A power analyzer from Yokogawa Test and Measurement Corporation (P/N: WT 5000) or any other
equivalent power analyzer should be used. An external Hall effect sensor can be used when the output current
exceeds the rating of the internal shunt resistor.

Oscilloscope: A 300 MHz or greater digital or analog oscilloscope with 100 MHz or greater isolated differential
voltage probes and isolated current probes (i.e., Hall effect) should be used.

Power Supplies: The following power supplies with isolated grounds should be used and must be obtained
separately:

1. 15V @ 1.5 A capability is required to supply the auxiliary power to the board.
2. 12VDC @ 6 A capability in total is required to power the cooling fans.

To use an external supply to power the auxiliary circuit, the user can connect the 15V to terminal J3 shown in
figure 24 and place jumper cap connectors (Ex: Wurth Elektronik PN: 60900213421) on P1 and P2 separately.
Alternatively, the user can use a Wolfspeed auxiliary flyback board that can be provided with the main board on
request.

Figure 24: Auxiliary Power Supply Connector

External Fans: Cooling fans should be used and must be obtained separately. As shown in Figure 25, at least 3
cooling fans (1 per phase), such as the Delta Electronics Inc. DC12 V/3.30 A fan (P/N: PFR0612XHE) or an
equivalent fan, must be used to cool the heatsink for each phase. The air flows through the heatsink to the PFC
choke and is enough for cooling the devices and the magnetics. The board is tested placing the MOSFETs and
choke side as the bottom as shown Figure 25 so that it creates an air chamber to provide a direction for airflow.
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Figure 25: Cooling fan setup for testing

Recommended Wire Gauge: Cable with a minimum AWG #8 wire gauge is recommended to carry the DC input

and output currents.

5.5 Testing the Unit in inverter Mode
5.5.1 Recommended Test Setup

(v, 1)

15V Auxiliary power
supply

(V,1)x 3

Power Analyzer

Yokogawa WT5000

Phase A
Phase B
Phase C

PGND
(Mid-point)

CRD-25BDA6512N-K
(uuT)

12V Auxiliary fan
power supply

L1’

12" FN3256H-64-34
L3 (Line Filter)

N g 2 13 N

L1 L2 13

3 Phase AC Resistive Load

Figure 26: Recommended test setup for inverter testing

5.5.2 Testing the Unit

The user can test the unit in inverter mode with open-loop and closed-loop control. The two labs that the user
can test for inverter mode are summarized in Table 4.
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Table 4: Inverter testing lab numbers summary

Lab Number Description Comments

2 Inverter: Open-Loop PWM  Check, ADC  check,
Protection Check, Inverter mode
DC bus connected and 3-phase
resistive load

3 Inverter: Closed Current Loop Output Current control with DC
bus connected and 3-phase
resistive load

Important Note: The firmware also has Lab 4 which can be used to test the inverter as a grid-connected
system, but this lab not been tested, and the gains have not been optimized on this board. The user is
advised not to test the inverter as a grid-connection system.

Lab2
To check the open-loop inverter operation of the board follow the steps listed below in order:

1. Connect the hardware as shown in figure 26 and turn on the auxiliary supplies
2. Inthetinv_settings.h file change the lab numberto 2 in line 91

#tdefine TINV_LAB 2

3. Build, load and debug the code, use the lab2.js file to populate the watch variables in the CCS window

4. In the expressions window, turn on the relay by writing a 1 to TINV_allRelaySet. The auxiliary power
supply should draw close to 550 mA

5. Setthe TINV_clearPWMTrip =1, to clear the PWM trip signal. Now the switching action begins. aAnd the
user can verify the open-loop PWM on the scope. At this point the auxiliary power supply should draw
close to 570 mA

6. Set up an appropriate resistive load around 1 kQ for the 3-phase load although the inverter mode can
be started at no load as well

7. The DCinput voltage can now be ramped up to 800V. The sinusoidal output should also be appearing
and increasing as the DC voltage is increased

8. TINV_vdInvRef_pu (default value is 0.845) is the modulation index that can be used to vary the AC
output of the inverter in open-loop fashion

9. Verify the sensed voltage and current measurement data in the graph window before proceeding to
close the current loop in Lab 3.

Only four signals can be viewed in Graph during one debug session. You can change these variables, build the
code, and start a debug session again to view different variables.

#ifndef _ TMS320C28XX_CLA__
TINV_dVall = TINV_iInv_A_sensed_Amps;
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TINV_dVal2 = TINV_iInv_B_sensed_Amps;
TINV_dVal3 = TINV_iInv_C_sensed_Amps;
TINV_dVald = TINV_vGrid_C_sensed_Volts;
DLOG_4CH_run(&TINV_dLogl);

t#tendif

Figure 27 shows a typical waveform from Lab 2, open loop inverter where Channels 2, 3 and 4 are phase A, B
and C output phase voltages respectively and Channels 1,6 and 8 and are phase A, B and C output line currents
respectively at 25kW output power.

510 148
WY

F/gure 27: Lab 2 Output phase voltages and line currents

To shut down the system:

1. Reduce the load gradually to no load

2. Turn OFF the DC source, wait until the DC source has fully discharged its output.

3. Turn OFF load after the bus capacitors are fully discharged.

4. Capacitors may remain charged for up to 30 minutes after the circuit is turned OFF if steps 3 or 4 are

skipped or compromised. They must be allowed to fully discharge before handling the board. Please
check the terminal voltages with the power analyzer or a digital multimeter to ensure that the board
has fully discharged and is therefore safe to handle.

5. Turn-off the auxiliary power supplies

Lab 3
To check the closed current loop inverter operation of the board, follow the steps listed below in order:

1. Connect the hardware as shown in figure 26 and turn-on the auxiliary supplies
2. Inthetinv_settings.h file change the lab number to 3 on line 91

#define TINV_LAB 3

3. The current compensator coefficients used for running the control loop are shown in the following
code. The user does not need to modify these gains, these gains are optimized to work with CRD-
25BDA6512N-K
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#define TINV_GI_PI_KP (((float32_t)@.250000)
#define TINV_GI_PI_KI ((float32_t)0.0075683544)

Build, load and debug the code, use the lab3.js file to populate the watch variables in the CCS window

In the expressions window, turn on the relay by writing a 1 to TINV_allRelaySet. The auxiliary power
supply should draw close to 550 mA

Set up an appropriate resistive load around 250 Q to start with although the inverter mode can be
started at no load as well

It is safe to start the inverter at low voltage first so slowly ramp the DC bus voltage to 400V

Set the TINV_clearPWMTrip = 1, to clear the PWM trip signal. Now the switching action begins, and
sinusoidal voltages start appearing at the output. At this point the auxiliary power supply should draw
close to 570 mA

As soon as TINV_clearPWMTrip is set, the TINV_closeGiLoop variable is enabled and closed current loop
action begins

TINV_idRef_pu is the current command reference and by default it is populated to a value of 0.01 pu at
start-up. Slowly vary this to increase the output AC voltage and observe measured current tracks the
commanded value.

Slowly ramp up the DC voltage to 800V now

Slowly increase id_ref_pu to 0.078 pu at 800-V input voltage to improve output power to 3.9kW

Figure 28 shows a typical waveform from Lab 3, closed current loop inverter where Channels 2, 3 and 4 are
phase A, B and C output phase voltages respectively and Channels 1, 5 and 6 and are phase A, B and C output

line currents respectively at 25kW output power.

Figure 28: Lab 3 Output line-line voltages and line currents

To shut down the system:

1. Decreaseid_ref_pu to reduce the current and output voltage while slowly decreasing the DC voltage
2. Turn OFF the DC source, wait until the DC source has fully discharged its output.
3. Turn OFF load after the bus capacitors are fully discharged.
4. Capacitors may remain charged for up to 30 minutes after the circuit is turned OFF if steps 2 or 3 are
skipped or compromised. They must be allowed to fully discharge before handling the board. Please
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check the terminal voltages with the power analyzer or a digital multimeter to ensure that the board
has fully discharged and is therefore safe to handle.
5. Turn off the auxiliary power supplies.

5.6 Test the unit in PFC mode
5.6.1 Recommended Test Setup

(V,)x 3
(v, 1) Power Analyzer
Yokogawa WT5000

Phase A L1

o 3 Phase B L2'  EN3256H-64-34
DC Resistive/E-load in Phase C L3’ Lrariier)
CR mode - oenD y
(Mid-point) L1 L2 L3 N

CRD-25BDA6512N-K
(UuT)

L1 L2 L3

15V Auxiliary power
supply

3 Phase AC Supply

12V Auxiliary fan
power supply

Figure 29: Recommended test set-up for PFC testing

5.6.2 Testing the unit
The user can test the unit in PFC mode with open-loop and closed-loop control. The three labs that the user can
test for inverter mode are summarized in Table 5.

Table 5: PFC testing lab numbers summary

Lab Number Description Comments

5 PFC: Open-Loop Check if phase sequence from AC
sourceis correct and PLL is locking

6 PFC: Closed current loop Output Current control with AC
source connected and DC
Electronic load in CR mode
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7 PFC: Closed voltage and current | Output voltage control with AC
loop source connected and DC
Electronic load in CR mode
Lab5

To check the PLL locking in open-loop PFC, follow the steps listed below in order:

1. Connect the hardware as shown in figure 29 and turn on the auxiliary supplies

2. Inthetinv_settings.h file change the lab number to 5 on line 91
#define TINV_LAB 5
3. Make sure the variables for datalogger/graph for lab 5 are:

#ifndef _ TMS320C28XX_CLA__

TINV_dVall = TINV_vGrid_A sensed_pu;
TINV_dval2 =

TINV_dVal3 = TINV_iGrid_A_sensed_pu;
TINV_dVal4 = TINV_iGrid_B_sensed_pu;

DLOG_4CH_run(&TINV_dLogl);
#endif

TINV_angleSPLL_radians / (float32_t)(2.0f * TINV_PI);

4. Make sure the grid frequency is specified correctly, the default F.c specified is 60Hz. It can be changed

in tinv_settings.h file:

#define TINV_AC_FREQ HZ ((float32_t)60)

5. Build, load and debug the code, use the lab5.js file to populate the watch variables in the CCS window
6. Connect suitable E-load in CR mode of about 2kQ. Make sure to use a high load resistance otherwise

can lead to high inrush currents triggering the overcurrent flag
7. Apply 50 Vrus AC voltage to the three phase terminals

8. Immediately turn on the relay by writing a 1 to TINV_allRelaySet. Rectified voltage should now start to

appear across the DC terminals

9. Inthe graph window, verify if the PLL locking as shown in figure 30. Cosine transforms are used hence

the angle will be 0 when the Vi, is at its peak.

BT = & % 5| A
Vinv S —
1 -’35 5 ,',L', 55 . 80 5 v:)i‘ 9
sample
e [ TN )
\, e _—r = \\ QL Sac= L. - e
PLL Angle
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Figure 30: PLL locking in PFC mode
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If PLL is not locking it could be for the following 2 reasons:
e The phase sequence for the AC supply is incorrect and needs to be reversed
e TheAC line frequency is different from the specified line frequency in firmware

If both of these are correct and the PLL still doesn’t lock, the user can try to reset the PLL by setting a
tinv_reset_PLLto 1.

10. Verify the rectified current being drawn due to the load on DC side
11. Clear the PWM trip by setting TINV_clearPWMTrip to 1 to see a slight boost in DC voltage

To turn off the board:
1. Turn of the AC source, wait until the AC source has fully discharged its output

2. Turn Off load after the bus capacitors are fully discharged.

3. Capacitors may remain charged for up to 30 minutes after the circuit is turned OFF if steps 2 or 3 are
skipped or compromised. They must be allowed to fully discharge before handling the board. Please
check the terminal voltages with the power analyzer or a digital multimeter to ensure that the board
has fully discharged and is therefore safe to handle.

4. Turn off the auxiliary power supplies

Important Note:
In Labs 5,6 and 7, in case PWMs do not turn on when the user sets TINV_clearPWMTrip to 1, it could be due to

an overcurrent fault flag which is set in one of the three phases and this happens under three circumstances:

1. On closing the relays, there is an inrush current which creates an overcurrent trip in one of the three
phases

2. When TINV_clearPWMTrip to 1, the switching action causes one of the flags to be set
3. Setting TINV_StartpowerStage to 1 for closing the current and voltage loop

The EPWM TZFLG is set to 0X000C and under this condition no switching occurs. The load resistance must be
increased so that the inrush currents will not cause a trip condition and the EPWM TZFLG changes from 0x0004
to 0x0000 and switching occurs.

Once the FLGis set to 0x000C, even if a TINV_reset_fault_status is performed to reset the faults, PWM action will
not be observed even though the faults may be cleared. The user will need to stop and debug the code again to
reset that fault status.

Lab 6

This lab is to check the closed current loop operation in PFC mode. It is always safe to start Lab 6 at low voltage
and low power as starting at higher power without a supervisory voltage loop can boost the voltage due to
overcurrent events and can blow away the switches. Hence, it is very important to carefully set the
TINV_idRef_pu variable to avoid overcurrent trips and high voltages at the DC terminals. Also, the
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TINV_idRef_pu is defined with a negative sign for PFC mode of operation and with a positive sign for inverter
mode of operation.

1. Connect the hardware as shown in figure 29 and turn on the auxiliary supplies
2. Inthetinv_settings.h file change the lab number to 6 on line 91
#define TINV_LAB 6
3. Make sure the variables for datalogger/graph for lab 5 are:
#ifndef _ TMS320C28XX_CLA__
TINV_dVall = TINV_vGrid_A_sensed_pu;
TINV_dVal2 = TINV_angleSPLL_radians / (float32_t)(2.0f * TINV_PI);
TINV_dVal3 = TINV_iGrid_A_sensed_pu;
TINV_dVald = TINV_iGrid_B_sensed_pu;
DLOG_4CH_run(&TINV_dLogl);
#endif

4. Make sure the grid frequency is specified correctly, the default F.. specified is 60Hz. It can be changed
in tinv_settings.h file:

#define TINV_AC_FREQ HZ ((float32_t)6e)

5. The current compensator coefficients used for running the control loop for PFC are shown in the following
code. The user does not need to modify these gains, these gains are optimized to work with CRD-
25BDA6512N-K

#define TINV_GI_PI KP (((float32_t)0.33000001)
#define TINV_GI_PI KI ((float32_t)0.0075683544)

6. Build, load and debug the code, use the lab6.js file to populate the watch variables in the CCS window

7. Connect suitable E-load in CR mode of about 2kQ. Make sure to use a high load resistance otherwise
can lead to high inrush currents triggering the overcurrent flag

8. Apply 50 Vrus AC voltage to the three-phase terminals

9. Immediately turn on the relay by writing a 1 to TINV_allRelaySet. Rectified voltage should now start to
appear across the DC terminals

10. Set TINV_idRef_pu to -0.015 pu

11. To start the PFC mode, enter "1" on TINV_startPowerStage variable, the current should now be drawn
from the grid as a sinusoidal signal (with some harmonics as it is at low power) and boost action seen
on the vBus. The output voltage boosts from 86 V to around 180 V.

12. The current becomes sinusoidal as the load is increased. This verifies start-up of PFC at 50 VRMS.

13. The user can now increase the input AC voltage slowly while increasing the TINV_idRef_pu to improve
the output voltage

14. Once the useris at 230V AC input and 800V DC output, the resistance is decreased to increase the load.
As there is no voltage loop in this lab, as the user decreases the resistance, the output voltage will drop
too. TINV_idRef_pu can be increased to maintain the output voltage
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To turn off the board:

1. Turn of the AC source, wait until the AC source has fully discharged its output

2. Turn Off load after the bus capacitors are fully discharged.

3. Capacitors may remain charged for up to 30 minutes after the circuit is turned OFF if steps 2 or 3 are
skipped or compromised. They must be allowed to fully discharge before handling the board. Please
check the terminal voltages with the power analyzer or a digital multimeter to ensure that the board
has fully discharged and is therefore safe to handle.

4. Turn off the auxiliary power supplies

Lab7

To check the closed current and closed voltage loop operation in PFC mode, follow the steps below:

1. Connect the hardware as shown in figure 29 and turn-on the auxiliary supplies
2. Inthetinv_settings.h file change the lab number to 7 on line 91
#define TINV_LAB 7
3. Make sure the variables for datalogger/graph for lab 5 are:
#ifndef _ TMS320C28XX_CLA__
TINV_dVall = TINV_vGrid_A_sensed_pu;
TINV_dval2 = TINV_angleSPLL_radians / (float32_t)(2.0f * TINV_PI);
TINV_dVal3 = TINV_iGrid_A_sensed_pu;
TINV_dVald = TINV_iGrid_B_sensed_pu;
DLOG_4CH_run(&TINV_dLogl);
#endif

4. Make sure the grid frequency is specified correctly, the default F.c specified is 60Hz. It can be changed
in tinv_settings.h file:

#define TINV_AC_FREQ_HZ ((float32_t)60)

5. The current compensator coefficients used for running the control loop for PFC are shown in the
following code. The user does not need to modify these gains, these gains are optimized to work with
CRD-25BDA6512N-K

#tdefine TINV_GI_PI _KP (((float32_t)0.33000001)
#define TINV_GI_PI_KI ((float32_t)0.0075683544)

6. The voltage compensator coefficients used for running the voltage control loop for PFC are shown in
the following code. The user does not need to modify these gains, these gains are optimized to work
with CRD-25BDA6512N-K

#define TINV_GV_PI_KP ((float32_t) 4)
#idefine TINV_GV_PI KI ((float32_t) ©.008)

7. Build, load and debug the code, use the lab7.js file to populate the watch variables in the CCS window

8. Connect suitable E-load in CR mode of about 2kQ. Make sure to use a high load resistance otherwise
can lead to high inrush currents triggering the overcurrent flag
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9. Apply 50 VRMS AC voltage to the three-phase terminals

10. Immediately turn on the relay by writing a 1 to TINV_allRelaySet. Rectified voltage should now start to
appear across the DC terminals

11. Set TINV_vBusRef_pu to 0.202 pu which corresponds to approximately 200V

12. To start the PFC mode, enter "1" on TINV_startPowerStage variable, the current should now be drawn
from the grid as a sinusoidal signal (with some harmonics as it is at low power) and boost action seen
on the vBus. The output voltage boosts from 86 V to around 200 V.

13. Now to verify start-up at 230Vac input, stop the code and debug the firmware again

14. Apply 230 Vrus AC voltage to the three phase terminals

15. Immediately turn on the relay by writing a 1 to TINV_allRelaySet. Rectified voltage should now start to
appear across the DC terminals

16. Set TINV_vBusRef_pu to 0.775 pu which corresponds to approximately 800V

17. To start the PFC mode, enter "1" on TINV_startPowerStage variable, the current should now be drawn
from the grid as a sinusoidal signal (with some harmonics as it is at low power) and boost action seen
on the Vbus. The output voltage boosts from 650 V to around 800 V. Start-up at 230 Vrms is shown in
figure 31.
Ch 1,5 &6 are phase A, B and C line currents respectively, Ch 2 is output Vbus voltage, Ch 3 is phase A
Vrms, Ch 4 is drain-source voltage across Q2 phase Aand Ch 7 and 8 are gate-to-source voltages of the
Q1 and Q2 switches of Phase A respectively.

Figure 31: 230Vac PFC start-up

18. In case any overcurrent trip is observed which causes the PWMs to switch off, please refer the note in
Lab 5 to debug this condition.

19. Load can now be increased to 25kW by lowering the resistance

To turn off the board:

1. Bringthe load down by increasing the resistance

2. Turn of the AC source, wait until the AC source has fully discharged its output

3. Turn Off load after the bus capacitors are fully discharged.

4. Capacitors may remain charged for up to 30 minutes after the circuit is turned OFF if steps 2 or 3 are
skipped or compromised. They must be allowed to fully discharge before handling the board. Please
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check the terminal voltages with the power analyzer or a digital multimeter to ensure that the board
has fully discharged and is therefore safe to handle.
5. Turn off the auxiliary power supplies

6. Test Results

6.1 Inverter Mode Test Results (DC-AC)

Table 6 shows the efficiency data for CRD-25BDA6512N-K in inverter mode switching at 60kHz switching
frequency. The efficiency curves are shown in figure 32.

Table 6: Inverter Mode Efficiency at 60kHz switching frequency and varied input and output voltages

Input Voltage Input Power (kW) Output Voltage Output Power Efficiency (%)
(vdc) (VAC) (kW)
670 3.69 400 3.66 99.20
670 7.02 400 6.97 99.27
670 10.76 400 10.68 99.25
670 14.47 400 14.34 99.13
670 18.07 400 17.89 98.99
670 21.38 400 21.13 98.82
670 24.92 400 24.56 98.57
800 3.32 380 3.28 98.71
800 6.37 380 6.31 98.98
800 9.69 380 9.60 98.98
800 13.07 380 12.93 98.90
800 16.43 380 16.23 98.79
800 19.57 380 19.31 98.65
800 22.97 380 22.60 98.47
800 26.47 380 25.98 98.35
800 3.70 400 3.65 98.68
800 7.09 400 7.02 99.00
800 10.74 400 10.63 99.00
800 14.56 400 14.41 98.94
800 18.20 400 17.98 98.79
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800 21.45 400 21.16 98.63
800 25.27 400 24.85 98.45
800 5.22 480 5.18 99.18
800 10.05 480 9.98 99.28
800 15.27 480 15.16 99.25
800 20.37 480 20.20 99.12
800 25.46 480 25.19 98.93
900 3.70 400 3.63 98.31
900 7.10 400 7.01 98.75
900 10.74 400 10.62 98.85
900 14.49 400 14.31 98.77
900 17.72* 400 17.48 98.64
900 5.21 480 5.16 98.90
900 10.04 480 9.95 99.10
900 15.22* 480 15.08 99.09

*Input Power at Vi,= 900V is limited by maximum current of the DC input supply used for testing

Efficiency (%)
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Typical waveforms for the inverter mode are summarized in table 7.

PRD-08613 REV. 2, Oct, 2024
© 2024 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak logo are registered trademarks and the Wolfspeed logo is a trademark of
Wolfspeed, Inc. Other trademarks, products, and company names are the property of their respective owners and do not imply specific product
and/or vendor endorsement, sponsorship, or association. This document is provided for informational purposes only and is not a warranty or a

specification. For product specifications, please see the data sheets at www.wolfspeed.com.

Figure 32: Inverter Mode Efficiency curve

CRD-25BDA6512N-K: 25kW Bi-Directional T-Type Inverter User Guide

43



Description

Lab 3: Half-load

(vin=800v’ Vout=
400V|.|, Fsw=
60kHz)

Ch 1,2 and 3- Phase
A,B,C line currents
respectively

Ch 4 and 5- V4 Q1
and Q3 respectively

Ch 6: Output Vims
phase A

Ch7:V,Q2

Table 7: Typical waveforms for CRD-25BDA6512N-K Inverter Mode

File Edit

Waveform View

Utility

Help

Waveform
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File  Edit  Utility  Help Tektronix

Inverter Start-up
at 800V, 3.9kW

Ch 1,2 and 3- Phase
A,B,C line currents
respectively

Ch4and5-V4 Q1
and Q3 respectively

Ch 6: Qutput Vims
phase A

Ch7:V,Q2
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RL: 1 Mpts. V218%

6.2 PFC Mode Test Results (AC-DC)
Table 8 and 9 show the efficiency data for CRD-25BDA6512N-K in PFC switching at 60kHz. The efficiency curves
are shown in figure 33 and 34.

Table 8: PFC Mode Efficiency at 60kHz switching frequency for varied input voltages

Input Voltage Input Power Load (%) Output Voltage OutputPower  Efficiency (%)

(Vline-line) (W) e 0

400 1285 5% 800 1253 97.251
400 2567 10% 800 2526 98.32
400 5088 20% 800 5033 98.88
400 7588 30% 800 7512 98.98
400 10332 40% 800 10231 99.02
400 12640 50% 800 12510 98.985
400 14298 60% 800 15088 98.93
400 16195 70% 800 17525 98.86
400 18973 5% 800 18745 98.8

400 20318 80% 800 20055 98.728
400 22374 90% 800 22574 98.64
400 25427 100% 800 25048 98.51
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380 1287 5% 800 1250 97.12
380 2565 10% 800 2522 98.31
380 5090 20% 800 5029 98.8

380 7588 30% 800 7507 98.93
380 10339 40% 800 10229 98.94
380 12651 50% 800 12509 98.88
380 15267 60% 800 15087 98.82
380 17754 70% 800 17527 98.72
380 18998 75% 800 18745 98.67
380 20324 80% 800 20037 98.59
380 22920 90% 800 22569 98.47
380 25462 100% 800 25044 98.36
480 1283 5% 800 1253 97.66
480 2560 10% 800 2526 98.68
480 5080 20% 800 5033 99.08
480 7571 30% 800 7512 99.22
480 10305 40% 800 10231 99.28
480 12605 50% 800 12510 99.25
480 15204 60% 800 15088 99.24
480 17668 70% 800 17525 99.19
480 18902 75% 800 18745 99.17
480 20231 80% 800 20055 99.13
480 22784 90% 800 22574 99.08
480 25296 100% 800 25048 99.02
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PFC Efficiency Curve
99.5
99
£ 985
>
()
c
(]
S 98
o= ———380Vac Input
97.5 = A00Vac Input
e A480Vac Input
97
0% 20% 40% 60% 80% 100% 120%
Power (% of 25kW)

Figure 33: PFC Efficiency Curve with Varying Input Voltages

Table 9: PFC Mode Efficiency at 60kHz switching frequency for varied output voltages

Input Voltage Input Power Load (%) Output Voltage OutputPower  Efficiency (%)

400 1285 5% 800 1253
400 2567 10% 800 2526 98.32
400 5088 20% 800 5033 98.88
400 7588 30% 800 7512 98.98
400 10332 40% 800 10231 99.02
400 12640 50% 800 12510 98.985
400 14298 60% 800 15088 98.93
400 16195 70% 800 17525 98.86
400 18973 75% 800 18745 98.8
400 20318 80% 800 20055 98.728
400 22374 90% 800 22574 98.64
400 25427 100% 800 25048 98.51
400 1283 5% 700 1256 97.89
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400 2598 10% 700 2567 98.81
400 5079 20% 700 5035 99.14
400 7572 30% 700 7513 99.22
400 10171 40% 700 10090 99.2
400 12631 50% 700 12525 99.16
400 15159 60% 700 15020 99.08
400 17729 70% 700 17552 99
400 18920 75% 700 18721 98.95
400 20785 80% 700 20550 98.87
400 22856 90% 700 22577 98.78
400 25361 100% 700 25024 98.67
400 1295 5% 850 1254 96.84
400 2634 10% 850 2589 98.29
400 5109 20% 850 5045 98.74
400 7593 30% 850 7508 98.88
400 10184 40% 850 10071 98.89
400 12725 50% 850 12585 98.9
400 15204 60% 850 15026 98.83
400 17778 70% 850 17556 98.75
400 18991 75% 850 18744 98.7
400 20295 80% 850 20023 98.66
400 22849 90% 850 22518 98.55
400 25423 100% 850 25024 98.43
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Figure 34: PFC Efficiency Curve with Varying output Voltages

The total harmonic distortion (THD) data for the current in each phase and the power factor data, both at 60kHz
switching frequency are summarized in table 10. The graph is shown in figure 35 and figure 36 for the THD and
power factor respectively.

Table 10: PFC Mode Current Distortion and Power Factor Data

Input Output Output Phase A Phase B Phase C
Voltage Voltage Power Current THD Current THD Current THD Power,
Factor
(Vi) (vDC) (W) (%) (%) (%)
400 800 1270 20.03 17.20 19.30 0.8960
400 800 1587 17.80 15.10 17.20 0.9490
400 800 3173 8.60 8.30 9.80 0.9844
400 800 5300 6.45 7.31 7.80 0.9919
400 800 7059 5.80 6.30 6.60 0.9952
400 800 9082 5.26 5.36 5.74 0.9965
400 800 12710 4.19 4.25 4.70 0.9975
400 800 15890 3.74 3.69 3.91 0.9982
400 800 17176 3.56 3.50 3.72 0.9985
400 800 19265 3.14 3.13 3.21 0.9988
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400 800 21178 3.16 3.01 3.10 0.9990
400 800 23012 2.88 2.90 2.87 0.9992
400 800 25002 2.69 2.71 2.71 0.9993
Current THD
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__14.00
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Figure 35: Current THD in PFC Mode
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1.0000
0.9800
IS 0.9600
©
©
T 0.9400
[
2
£ 0.9200
0.9000
0.8800
5000 10000 15000 20000 25000 30000
Power (W)
Figure 36: Power Factor results in PFC Mode
Typical waveforms for the PFC mode are summarized in table 11.
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Lab 7: Half-load

(vin=4oovl-l, vout=
800V, Fsw=
60kHz)

Ch1,2and 3-
Phase A,B,C line
currents
respectively

Ch 4 and 5- V4 Q1
and Q3
respectively

Ch 6: Output Vdc
mid-point voltage

Ch7: Vg Q2

Table 11: Typical waveforms for CRD-25BDA6512N-K PFC Mode
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Lab 7: Full-load
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Lab 7: PFC Start-
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6.3 Thermal Test Results

This design is tested with forced air cooling with direct flow of air on the MOSFETSs and heatsink by placing the
cooling fans and the board as shown in figure 25. The fan for each phase is a 12V fan operating at approximately
8W power. The case temperature reading of each switch was taken using a K-type thermocouple and an Agilent
34970A Data logger unit.

The test results under these conditions are shown in Table 12. The highest case temperature among all three
phases of a 1200V switch and a 650V switch is noted for both Inverter and PFC modes. The junction temperature
is calculated based on the measured case temperature, the thermal resistance of the MOSFET from junction to
case, and the calculated power loss.

The maximum junction temperature for C3M0032120K and C3M0025065K is 175°C and the derating
requirement for T;is 135°C. The results below show that the SiC MOSFETs meet the derating requirementsin all
test conditions and therefore pass the thermal tests.

Table 12: Thermal test results of SiC power MOSFETs in CRD-25BDA6512N-K

Rin Calculated @ Measured | Calculated | Max. Operating Derating

Description (j-c) Power loss Case Junction | junctiontemp Requirem Result
(°c/w) (w) Temp. (°C) Temp. (°C) (°C) ent (°C)
Inverter Mode: 800Vdc 400Vac 25kW 60kHz
C3M0032120K
0.44 28.5 58.2 70.5 175°C 135°C Pass
Q1_A
C3M0025065K
0.46 11 55.5 60.6 175°C 135°C Pass
Q3_A
PFC mode: 380Vac 800Vdc 25kW 60kHz
C3M0032120K
0.44 18.2 57.9 65.9 175°C 135°C Pass
Q1_C
C3M0025065K
0.46 155 65.3 72.4 175°C 135°C Pass
Q3_C
PFC mode: 400Vac 850Vdc 25kW 60kHz
C3M0032120K
0.44 17 55.1 62.6 175°C 135°C Pass
Q1_C
C3M0025065K
0.46 13.8 62.5 68.9 175°C 135°C Pass
Q3_C
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IMPORTANT NOTES

Purposes and Use

Wolfspeed, Inc. (on behalf of itself and its affiliates, “Wolfspeed”) reserves the right in its sole discretion to make
corrections, enhancements, improvements, or other changes to the board or to discontinue the board.

THE BOARD DESCRIBED IS AN ENGINEERING TOOL INTENDED SOLELY FOR LABORATORY USE BY HIGHLY
QUALIFIED AND EXPERIENCED ELECTRICAL ENGINEERS TO EVALUATE THE PERFORMANCE OF WOLFSPEED
POWER SWITCHING DEVICES. THE BOARD SHOULD NOT BE USED AS ALL OR PART OF A FINISHED PRODUCT.
THIS BOARD IS NOT SUITABLE FOR SALE TO OR USE BY CONSUMERS AND CAN BE HIGHLY DANGEROUS IF NOT
USED PROPERLY. THIS BOARD IS NOT DESIGNED OR INTENDED TO BE INCORPORATED INTO ANY OTHER
PRODUCT FOR RESALE. THE USER SHOULD CAREFULLY REVIEW THE DOCUMENT TO WHICH THESE
NOTIFICATIONS ARE ATTACHED AND OTHER WRITTEN USER DOCUMENTATION THAT MAY BE PROVIDED BY
WOLFSPEED (TOGETHER, THE “DOCUMENTATION”) PRIOR TO USE. USE OF THIS BOARD IS AT THE USER’S SOLE
RISK.

Operation of Board

It is important to operate the board within Wolfspeed’s recommended specifications and environmental
considerations as described in the Documentation. Exceeding specified ratings (such as input and output
voltage, current, power, or environmental ranges) may cause property damage. If you have questions about
these ratings, please contact Wolfspeed prior to connecting interface electronics (including input power and
intended loads). Any loads applied outside of a specified output range may result in adverse consequences,
including unintended or inaccurate evaluations or possible permanent damage to the board or its interfaced
electronics. Please consult the Documentation prior to connecting any load to the board. If you have any
questions about load specifications for the board, please contact Wolfspeed at forum.wolfspeed.com for
assistance.

Users should ensure that appropriate safety procedures are followed when working with the board as serious
injury, including death by electrocution or serious injury by electrical shock or electrical burns can occur if you
do not follow proper safety precautions. It is not necessary in proper operation for the user to touch the board
while itis energized. When devices are being attached to the board for testing, the board must be disconnected
from the electrical source and any bulk capacitors must be fully discharged. When the board is connected to an
electrical source and for a short time thereafter until board components are fully discharged, some board
components will be electrically charged and/or have temperatures greaterthan 50° Celsius. These components
may include bulk capacitors, connectors, linear regulators, switching transistors, heatsinks, resistors and SiC
diodes that can be identified using board schematic. Users should contact Wolfspeed for assistance if a board
schematic is notincluded in the Documentation or if users have questions about a board’s components. When
32 PRD-07561 REV.1, January 2024 © 2024 Wolfspeed, Inc. All rights reserved. Wolfspeed® and the Wolfstreak
logo are registered trademarks and the Wolfspeed logo is a trademark of Wolfspeed, Inc. Other trademarks,
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purposes only and is not a warranty or a specification. For product specifications, please see the data sheets at
www.wolfspeed.com. operating the board, users should be aware that these components will be hot and could
electrocute or electrically shock the user. As with all electronic evaluation tools, only qualified personnel
knowledgeable in handling electronic performance evaluation, measurement, and diagnostic tools should use
the board.

User Responsibility for Safe Handling and Compliance with Laws

Users should read the Documentation and, specifically, the various hazard descriptions and warnings
contained in the Documentation, prior to handling the board. The Documentation contains important safety
information about voltages and temperatures.

Users assume all responsibility and liability for the proper and safe handling of the board. Users are responsible
for complying with all safety laws, rules, and regulations related to the use of the board. Users are responsible
for (1) establishing protections and safeguards to ensure that a user’s use of the board will not result in any
property damage, injury, or death, even if the board should fail to perform as described, intended, or expected,
and (2) ensuring the safety of any activities to be conducted by the user or the user’s employees, affiliates,
contractors, representatives, agents, or designees in the use of the board. User questions regarding the safe
usage of the board should be directed to Wolfspeed at forum.wolfspeed.com.

In addition, users are responsible for:

e compliance with all international, national, state, and local laws, rules, and regulations that apply to
the handling or use of the board by a user or the user’s employees, affiliates, contractors, representatives,
agents, or designees.

e taking necessary measures, at the user’s expense, to correct radio interference if operation of the
board causes interference with radio communications. The board may generate, use, and/or radiate radio
frequency energy, but it has not been tested for compliance within the limits of computing devices pursuant to
Federal Communications Commission or Industry Canada rules, which are designed to provide protection
against radio frequency interference.

e compliance with applicable regulatory or safety compliance or certification standards that may
normally be associated with other products, such as those established by EU Directive 2011/65/EU of the
European Parliament and of the Council on 8 June 2011 about the Restriction of Use of Hazardous Substances
(or the RoHS 2 Directive) and EU Directive 2002/96/EC on Waste Electrical and Electronic Equipment (or WEEE).
The board is not a finished end product and therefore may not meet such standards. Users are also responsible
for properly disposing of a board’s components and materials.
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THE BOARD IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING BUT NOT LIMITED TO ANY
WARRANTY OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE, WHETHER
EXPRESS OR IMPLIED. THERE IS NO REPRESENTATION THAT OPERATION OF THIS BOARD WILL BE
UNINTERRUPTED OR ERROR FREE.

Limitation of Liability

INNO EVENT SHALLWOLFSPEED BE LIABLE FORANY DAMAGES OF ANY KIND ARISING FROM USE OF THE BOARD.
WOLFSPEED’S AGGREGATE LIABILITY IN DAMAGES OR OTHERWISE SHALL IN NO EVENT EXCEED THE AMOUNT,
IF ANY, RECEIVED BY WOLFSPEED IN EXCHANGE FOR THE BOARD. IN NO EVENT SHALL WOLFSPEED BE LIABLE
FORINCIDENTAL, CONSEQUENTIAL, OR SPECIAL LOSS OR DAMAGES OF ANY KIND, HOWEVER CAUSED, OR ANY
PUNITIVE, EXEMPLARY, OR OTHER DAMAGES. NO ACTION, REGARDLESS OF FORM, ARISING OUT OF OR IN ANY
WAY CONNECTED WITH ANY BOARD FURNISHED BY WOLFSPEED MAY BE BROUGHT AGAINST WOLFSPEED MORE
THAN ONE (1) YEAR AFTER THE CAUSE OF ACTION ACCRUED.

Indemnification

The board is not a standard consumer or commercial product. As a result, any indemnification obligations
imposed upon Wolfspeed by contract with respect to product safety, product liability, or intellectual property
infringement do not apply to the board.
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